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Presenting Author Guidelines – Oral Presentations 
 

The 55th International Congress & Exposition on Noise Control Engineering – INTER-NOISE 2026, Adelaide – 

Congress Organising Committee would like to thank you for being a Presenting Author. Your continued contribution 

to the high quality and smooth running of the Congress is highly valued and appreciated.  

 

The role of the Presenting Author is to prepare and present in English a clear, concise and easy-to-follow ORAL 

presentation of the work described in the associated accepted paper in the allocated slot in the Congress, either In-

person or Online via a pre-recorded video equivalent, submitted in advance of the Congress.  

 

Presenting authors MUST be registered for the Congress. ALL presenting authors – whether presenting Online or In-

person – are required to upload a (pre-)recording of their presentation. This is for the benefit of all IN26 delegates, 

especially those that are online and cannot, therefore attend the live oral presentations in the session.  

 

Online presenting authors must upload their pre-recorded video presentations one week prior to commencement of 

the Congress, i.e. by Sunday 2nd August 2026, 16:30 AEST. Failure to upload a presentation within this timeframe will 

result in the submission being withdrawn from the Congress including the paper not being available in the 

Proceedings nor subsequently in the I-INCE Digital Library. 

 

In-person presenting authors must upload their video presentation no more than one week after commencement of 

the Congress, i.e. by Sunday 16th August 20226, 16:30 AEST for it to be made available to other delegates via the 

unique hyperlink that will be included in the (digital) Proceedings and in the Congress App.  

 

Recordings will not be captured at the Congress in the rooms (with the exception of the keynotes and plenaries 

along with the Opening and Closing ceremonies), nor will live presentations be streamed online. Authors are thereby 

strongly encouraged to make the effort to and follow the requirements and recommendations of the Congress as set 

out herein to produce high-quality presentations and recordings to maximise the reach and impact of their work.  

 

The full Final Technical Program will be available on the Congress Website and, ultimately, via the Congress App. 

Once the latter is available to delegates, we will up-issue this document including instructions how install and use it. 

 

Preparation of your presentation slideset 

Please carefully read and follow the instructions within the IN2026_Presentation_Template16by9.pptx included in 

Templates for Authors on the INTER-NOISE 2026 website: https://internoise2026.org/templates-for-authors/. While 

authors are free to use the provided templates these are not compulsory. Presenting authors may use their own 

branded templates or otherwise, provided they adhere to the requirements set out in the presentation template.  

 

Authors are strongly encouraged to review Will’s YouTube video on how to use the PowerPoint template embedded 

within the Templates for Authors page or here: https://www.youtube.com/watch?v=0AZE8V9MuJk&t=1s. Authors 

are also encouraged to read the Author FAQs, here: https://internoise2026.org/authors-faq/. 
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Preparation of your MANDATORY presentation video 

Whether you are attending the Congress to present In-person or engaging Online, you must prepare and upload a 

high-quality 15 min maximum video recording (in MP4 Full HD 1080P format H.264 compression).  

 

There are various ways to do this, depending upon but not limited to: i) which kind of device/operating system 

(Windows/Mac e.g.) you use; ii) which slideset preparation software (PowerPoint/Keynote/Acrobat e.g.) you 

use/prefer; iii) which online meeting solution (zoom, Teams, other) you use/prefer; etc..  

 

In the Appendix, we make some example suggestions – which we know can be used to produce excellent outcomes – 

but we leave it to you to ultimately decide which solution to use depending upon what works best for you.  

 

Uploading/submission of your MANDATORY presentation video 

Uploading the video with the correct naming (IN2026_Recording_xxxx.mp4) is important for the smooth running of 

the Congress – we rely on your support and diligence to enable this for the benefit of all involved. Please refer to the 

information and instructions in your email for the unique details and link of where to upload this file. Thank you. 

Instructions for Online presenting authors only 

At least 1 wk before the Congress (i.e. by Sunday 2nd August 2026, 16:30 AEST) 

Upload your 15 min presentation video (MP4 Full HD 1080P format H.264 compression) to the unique link provided 

in the email with the correct filename (IN2026_Recording_xxxx.mp4). You do not need to do anything else! 

The Congress Organiser in collaboration with the A/V team at the Adelaide Convention Centre will quickly check your 

file plays including working audio* and allocate it to the corresponding session (determined based on the paper #, 

hence why the importance to include this in the filename). The session chair will play the video at the allotted time. 

(Re-)familiarise yourself with the Final Technical Program (available here: https://internoise2026.org/program/ or in 

the App), including the timing of the session and your talk therein. Install the Congress App and make contact with 

the Session Chair(s) for your session via chat/messaging; their name(s) are included the Program. Optionally, 

favourite your session/talk and set yourself a reminder. 

 

*This is only a functional, not a quality check; if there is a problem, you will be contacted to upload a fixed version. 

 

20 minutes prior to the commencement of your session 

Launch the INTER-NOISE 2026 Congress App and re-establish communication via the chat/messaging with the 

Session Chair(s).  

 

During the session 

There will be no video/audio feed available during the session at INTER-NOISE 2026.  

Your Session Chair(s) will play the pre-recording of your presentation at the allotted time. During the Q&A, they will 

engage with the audience in the room, directing any questions to you via the App. Please be prepared to respond 

promptly to the comments/questions shared. Session Chair(s) may also advise delegates to contact you directly.  

We hope that the experience that you and the delegates have with this communication option is beneficial. We 

would have preferred for all presenting authors to have been in attendance but understand that for some, this was 

unfortunately not possible. 

 

pto 
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Instructions for In-person presenting authors only 

 

At least ½ a day before your session 

Please attend the Speakers’ Preparation Room, nearby to/signposted from the Conference Organiser desk to upload 

your slideseet into the Conference Centre A/V system.  

There will be technical support available to help you to ensure your slides work as intended. Please pay particular 

attention to any equations, special fonts, animations/transitions and any video/audio clips. 

Please do this at least ½ a day before your session to ensure there is time to prepare the session. I.e. if you are 

presenting on Mon am, please attend the Speakers’ Preparation Room on Sunday afternoon, etc.. 

Optionally thereafter, you may wish to visit Riverbank Room 1 ahead of your session to practice your presentation in 

an environment/set-up which is consistent with that in the other rooms within the Conference Centre. 

Install the Congress App and review the Program. Optionally, favourite your session/talk and set yourself a reminder. 

Before your presentation 

(Re-)familiarise yourself with the Final Technical Program (available here: https://internoise2026.org/program/ or in 

the Congress App), including the timing of the session and your talk therein.  

Arrive 20 minutes before your session begins, allowing time to meet your Session Chair(s), confirm your details with 

them and become acquainted with the room setup. Confirm your name pronunciation if required.  

Quickly verify your presentation loads and looks as expected, inc. any fonts and video/audio. You will already have 

confirmed this in Speakers’ Preparation Room when you uploaded your slideset.  

Your Session Chair(s) will remind you of the time constraints and explain the warning system that they may use to 

signal to you of the remaining time. You may also want to use a timer on your watch or phone.  

Please sit towards the front of the room and be ready. 

During the session 

Introduction by Session Chair 

Your Session Chair will briefly introduce you by your name plus some info from your submitted Bio. They have been 

asked not to read your title or affiliation etc. as you will do that when you start your talk. 

Session timing  

The 20 min presentation time listed in the Technical Program is to include the Session Chair’s brief introduction, your 

presentation (15 min), question and discussion time (3 min), and presenter transitions (2 min) at the conclusion of 

your talk. Please do not run long; you may use your watch or phone to time yourself so that you stay on track.  

Question and Answers 

Following each presentation, if time permits, be prepared to answer one or two questions which will be managed by 

the Session Chair(s). Online delegates may also submit questions via the Congress App at the time (which the 

Chair(s) will relay to you) or afterwards directly to you. Instructions for using the App are provided at the end of this 

document (in a subsequent revision, once available). 

 

Immediately after the session 

Session Chairs’ wrap-up 

Please consider checking in with your Session Chair(s) immediately following the session, especially if you have any 

comments (on the room, A/V, organisation etc.) that they might include in the Session Feedback Form that they have 

been asked to complete. 
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Presenting Author Frequently Asked Questions (FAQs) 

Please refer to the Authors’ FAQs on the Congress Website where there is a dedicated PRESENTATION section: 

https://internoise2026.org/authors-faq/  

 

Keeping time 

Each presentation slot is 20 minutes in duration: 

15 minutes – Presentation 

3 minutes – Q&A 

2 minutes – Changeover 

Use watch or phone to keep yourself to time. 

Session Chair(s) may use provided cards to notify 

presenters of time left. 

 

Changeovers 

2 minutes between presentations has been allowed 

for. 

 

Please be ready to change over to minimise delays. 

If Time Is Running Short 

Shorten or conclude your talk quickly if necessary/if 

asked to do so by the Session Chair(s). 

 

Presentations must not exceed their allocated time. 

Maintaining the published schedule is critically 

important to allow delegates to follow their 

preferred talks. 

End of the Session 

Check in with your Session Chair(s) before leaving in 

case you have any comments/feedback to share. 

 

If you have any inquiries, please do not hesitate to contact conference@aomevents.com or for urgent enquiries 

during the Congress see the All Occasions Group team at the Registration Desk or call us Congress Organiser Ms 

Jackie Habis, AOG on +61 (0) 451 107 438..  

 

Thank you once again for your valuable contribution to the Congress! 

Kind regards, 

All Occasions Group – on behalf of the 55th INTER-NOISE Congress Organising Committee 

 

 

 

 

 

 

 

 

Principal Partners 

 

mailto:conference@aomevents.com
https://internoise2026.org/
https://internoise2026.org/
https://internoise2026.org/authors-faq/
mailto:conference@aomevents.com


conference@aomevents.com | internoise2026.org 

Congress App installation and usage instructions 

To be confirmed in subsequent revision once the App is available. 
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Appendix – Some options for creating the required high-quality video recording 

Option 1: Narration of individual slides within PowerPoint followed by Export… to MP4 

Once you have completed your slideset (15 slides maximum recommended), Insert -> Audio > Audio from file… OR 

Record Audio… (see left screenshot below) to create narration for each slide. Once created/imported, go to Playback 

(1) and set Start: to Automatically (2) and, optionally, check Hide During Show (3) (see right screenshot below). 

 

  
 

Please ensure that you select a good microphone and record the narration in a quiet room. Ideally record all the 

narration for each slide during the same session and/or conditions (such that the audio levels for all slides are the 

same). Note that the summation of the durations of each of the slides should clearly be no more than 15 minutes. 

 

Benefit: For presenters for whom English is not their mother tongue, it may be possible to use additional (e.g. 

Generative AI – supervised!) tools to translate into English language clips and import these into each slide instead. 

 

Once completed for all slides*, use File -> Export… (interface shown below for Microsoft® PowerPoint for Mac 

Version 16.110.1 (26062112); other solutions should be equivalent), save the file as MP4 (with H.264 compression) 

in Full HD 1080P with the filename IN2026_Recording_xxxx.mp4 (where xxxx is your 4-digit paper number; please 

insert 0s at the front if your paper number is less that 4 digits):  

 

 

 
*Slides without audio – e.g. section slides – can be given a default duration, e.g. 5 seconds. 

 

Option 2: (Rehearse Timings and) Record Slideshow directly in PowerPoint 

Once you have completed your slideset (15 slides maximum recommended), (optionally use Rehearse Timings to 

practice and then) Record Slide Show to capture a video of you talking through your presentation (interface shown 

below for Microsoft® PowerPoint for Mac, Version 16.110.1 (26062112); other solutions should be equivalent):  

 

1 
2 3 
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This option works similarly to Option 1 in that each slide will have audio associated with it which is captured while 

you are showing that slide. It works better if you are connected to a second screen or projector on which the slides 

are shown, while control of audiovisual capture is on the primary screen as shown in the screenshot above. You can 

pause and resume the recording (1) or delete the narration and re-record it on a per slide basis. The total duration 

of the presentation of all slides with audio is shown (2) and updates as you go so you can adapt. Teleprompter View 

or Presenter View can be selected (3), depending upon your preference. If you have a video camera, you can choose 

to use that (4); the captured video can be resized/repositioned on each slide later. You can include notes (5) and use 

manifestations such as the laser pointer or annotated with pen and highlighter etc. (6) to enhance your recording. 

 

This option will be preferable over the Option 1 if you have animations/transitions within the slides, will present 

audio/video clips or have other complications. Again, select a good microphone and record in a quiet room, ideally 

completing it in a single session. 

 

As for Option 1, use File -> Export… to create the video as MP4 (with H.264 compression) in Full HD 1080P with the 

filename IN2026_Recording_xxxx.mp4, where xxxx is your unique, four-digit INTER-NOISE 2026 paper number.  

 

1 
2 

4 

4 

5 6 
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Example Option 3: Self-recording during zoom or Teams meeting 

Once you have completed your slideset (15 slides maximum recommended), start a zoom or Teams meeting, share 

your screen, present your slides and start the recording, talking and advancing through them in front of your screen 

as you normally would if giving the presentation in person in front of a live or online audience.  

 

Like for Option 2, you can also choose whether or not to also capture video from your webcam, for example in the 

top-right corner of the screen while presenting. This enhancement can improve the experience for the viewer. 

 

Please remember to share the computer audio when you share to the zoom/Teams meeting if you have clips with 

audio in your slideset. Typically, this option involves creating the video in one go, rather than slide-by-slide. You may 

need to make multiple attempts to get an outcome that you are happy with. It may be preferable if you plan to show 

content from outside the slideset, e.g. from webpages or other applications that you are running/demonstrating. 

 

Again, one completed, create/export the video as MP4 (H.264 compression) in Full HD 1080P with the filename 

IN2026_Recording_xxxx.mp4, where xxxx is your unique, four-digit INTER-NOISE 2026 paper number. 
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